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Lesson Objectives

Learn about the different formats available for sales forms

Save sales and purchase forms in portable document format (PDF)
Practice creating a new invoice

Learn the purpose and use of the QuickBooks Item list

See how QuickBooks records the information you enter on sales forms
Memorize an invoice transaction for reuse

Add a new item to the Item list

Add a new price level to the Price Level list

Associate a price level with a customer

Create invoice letters

Generate reminder statements

QuickBooks Desktop 2021 Client Training 5
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Use Sales Forms for Payment in the Future

Any time you make a sale in your business, you record it in QuickBooks on a sales form. A sales form
can be an invoice (when you expect payment to come later), a sales receipt (when you receive
payment at the time you make the sale), or a credit memo (when you issue a credit on your
customer’s account or a customer refund, perhaps because they've returned something they've
bought).

The type of sales form you use (invoice or sales receipt) depends on whether you expect payment in
the future or at the time of the sale. If you expect to receive payment at some future date, you enter
an invoice. This records the sale and updates your Accounts Receivable with the total amount of that
invoice.

@
o Step-by-Step: Display a Completed Invoice Form in QuickBooks

1. Open the Customer Center from the Customers drop-down menu (or any of the other access
points).
2. Click the name of the customer whose invoice you would like to view.

3. From the Transactions tab for that customer, double- the invoice you want to view to open the
invoice form.

QuickBooks Desktop 2021 Client Training 6
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omer Center- Abercy

& New Customer & Job v New Iransactions ¥ &5 Print ¥ Word ¥ &8 income Tracker
Customers & Jobs Customer Information 612 4o
ActheCyslomer - > Company Name iain Fhone 415-555-6579 9/1512003: Send Kristy
P Fulllame Mrs. Kristy Abercrombie Main Email Kristy@samplename.com estimate for den remodel
Customer Type  Residential 912012003: Called Kristy to
NauE BALANCE . ATTA
+ ADercrombie, Krisly 0.00 i Accountllo. 91-431 REPORTS FOR THIS CUSTOMER
' Terms Net30
oFamily Room 0.00 s Koty Abercrombie QuickReport
oFinished Bassment 0.00 5647 Cypress Hill Rd Open Balance
eKitenen o.00 Barshore Chsasze Show Estimates
«Remodel Bathroom 0.00 e et
+ Alard, Robert 1451000 Transactions | Contacts ToDo's Notes Sent Email
oRemodel 14,510.00
+ Babeocks lusic Shop 000 swow |AllTransacions v | susesy (Al ~ | oae This Fiscal Year v | 010112025 - 1213112025
«Remodel 0.00 TveE ©om ATE ¥ NT ¥ AnOUNT
+ Baker, Chris 0.00 Payment 1211512025 10100 - Checking 7633.28
+Family Room 0.00 Estimate 613 1211212025 90200 - Estimates 7,676.13
«Garage Repalr 0.00 Invoice 1091 1211012025 11000 - Accounts Receivable 522,00
» Balak, Mike 0.00 Check 478 1210112025 10100 - Ghecking 71115
o Utity Shed 0.00 . |Credithemo 4002 1200112026 11000 - Accounts Receivable 71115
bty e o0 T et
+Repairs 0.00 Sales Receipt 3008 1013012025 10100 - Checking 743.75)
+ Bauman, Mark 0.00 Estimate 606 1013012025 90200 - Estimates 311400
oHome Remodel 0.00 Sales Receipt 3004 1012512025 10100 - Ghecking 1,06788
+ Bolinsk, Rafal 0.00 Payment 120342 0811612025 12000 - Undeposited Funds 120278
o 2nd story addition 0.00 Sales Order 7000 0610712025 90300 - Sales Orders 1,203.00
+ Bristol, Sonya 0.00 Invoice 1043 0610712025 11000 - Accounts Receivable 1,20278
Repairs 0.00 Invoice 1044 0610712025 11000 - Accounts Receivable 0.00
oUtilty Shed 0.00 Payment 8438 021202025 12000 - Undeposited Funds 5012.08
+Buren, Jason 1,005.00 Invoice 1024 0200112026 11000 - Accounts Receivable 501008
«Room Addition 1,005.00,
+ Gampbell, Heatner 13,900.00
oRemodel 13,900.00
» Carrs Pie Shop 0.00
«Remodel 0.00
+ Casillo, Eloisa 0.00
+BayWindow 0.00
»Utilty Room 0.00 Manage Transactions | Run Reports v
v
eate Invoice: 1
Main Formatting Send/Shi Reports g oAl

e> B BH R Boeeacw @ ([ Prtater ) BacaTmecos [ [~}

Find New Save Delete @dMemorize Mark As Print  Emal [ | Emaillater  Attach | @ Apply Gredis  Progress  Receive B Refund/Credit
S 2 Pending S < File Payments

Remodn - Rk Castle e - _ > Abercrombic, Kristy:Remodel B...
Customer
H DATE BILLTO SHIF TO ShipTo 1 hd
Invoice s sz w - ¢
€@ FaD 12152025 INvoIcE = g:;:ﬁ:’;‘g:”zﬁm g:;;a:’scfg'ﬂ;d Phone 415-555-6579
1084 Email fristy@samplename com
Preferred delivery method E-mail
TERMS DUE DATE Open balance 0.00
Net 30 ~ 12025/2026 [ Active estimates 1
‘ ‘ . . . Sales Orders to be invoicsd 0
TEm | DESCRIPTION fouantiTy§um i RaTe Pa Tax Unbilled time and expenses: 1.910.00
See attached specifications for details on below Work a
Framing Framing labor 0 7150 000 Non CUSTOMER PAYMENT ¢
Installation Installation labor 0 4550 0.00 Non Your customer can not pay online
Remaval Removal labor 0 4550 000 Non Edit customer preferences
Subs:Tile &Coun... Install tile or couter 0 825.00 0.00 Nen
SubsElecirical  Electrical work 0 275.00 000 Non RECENT TRANSACTION
Subs:Painting Painting 0 154.00 0.00 Non 1215125 Payment 763328
SubsPlumbing  Plumbing 0 550.00 0.00 Non 12112125 Estimate 767613
PlUMD Fixtrs Whirlpool bath 2 660.00 1,320.00 Tax otEs &
PlUMD Fixtrs Tolet 2 37400 748.00 Tax
PIUMD Fixtrs sink 3 18150 54450 Tax
PlUMD Fixtrs Glass door for showers 2 137.50 27500 Tax
EquipRental  Equipment Rental 0 30000 0.00 Non
v
e Your customer can't pay this invoice oniine 4 (8anTomas (7.75%) 22378
Turn o TOTAL 3.111.28
CUSTONER MESSAGE PAYMENTS APPLIED 3.111.28
— saLANGE DUE 0.00
yEMO cusoer Tax v save & Close Revert
Rl —

4. Close the invoice (it's already been created and saved, and so you can just hit the Esc key to
close it).
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Use Sales Forms for Payment at the Time of Sale

If you receive full payment at the time you make a sale — either by cash, check or credit card — you fill
out a sales receipt instead of an invoice. Like the invoice, the QuickBooks sales receipt includes

information about the items or services purchased, but it also includes information about how
payment was made. (Think of the sales receipt as the QuickBooks equivalent of a cash register
receipt at a retail store.) The sales receipt completely bypasses the Accounts Receivable account.

@

o Step-by-Step: Display a Completed Sales Receipt in QuickBooks

1. Open the Customer Center from the Customers drop-down menu (or any of the other access points).

2. Click the name of the customer whose sales receipt you would like to view.

3. From the Transactions tab for that customer, double-click the sales receipt you want to view to

open the Sales Receipt form.

Note the Deposit To account (whether it's the Checking account, other bank account, or

Undeposited Funds). Undeposited Funds will be discussed in more detail in Lesson 7 under

Make Deposits.

= Enter Sales Receipts - 0O X
Main ~ Formatting  Send/Ship  Reports  Payments 2 oA
«» B H X CreateaCopy @ & & | Prntiater © B eoamerosts P @
Find New Save Delete @BMemorize  MarkAs ~ Print  Emal [ | Emaillater  Afiach
= £ Pending S o File Ang'(;::‘:::m
B8 Remodel w FE2Eha o) 10100 - Checking « PRV RS 8 Custom Sales Receipt
Customer Transaction
H B oL To &
Sales Receipt o R— m—
101252025 B 5547 Cypress Hill Rd Phone 415-565-6579
— = | = | nowe - Bayshore CA94326
iH == =] Email kristy@samplename.com
CASH cueck | CREDT | . cueck v eI Open balance 0.00
CHECK NO Active estimates 0
3674 Sales Orders to be invoiced o
ITEM DESCRIFTION aTy um RATE AMOUNT TAX Unbilled time and expenses:  217.94
Remaval Removal labor - cleaned up backyard in preparation for deck 65 35.00 227.50 Non 0
Installation Installation Iabor - installed new deck 4 35.00 140.00 Mon E
LumberDecking  Decking lumber 650.00 650.00 Tax RECENT TRANSACTION
10/30/25 Sales Receipt 74375
1012525 Sales Receipt 1,067 88
08M5/25 Payment 120278
06/07/25 Invoice - Paid 0.00
06/07/25 Sales Order 1,293.00
NOTES I'4
v
T San Tomas -  (7.75%) 50.38
TR 1,067.88
CUSTONER MESSAGE
-
veuo - Save & Close Revert
QuickBooks Desktop 2021 Client Training 8
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Fill in a Sales Form

Filling in an invoice is just like filling in a paper form: enter the customer information first (this will
populate the header portion of the invoice), followed by a description of the charges (this will
populate the detail portion of the invoice).

@
©. Step-by-Step: Enter Customer Information on an Invoice

1. Onthe Home page, click Create Invoices (or select CTRL+i or Customers - Create Invoices;
there are several other ways to open the Create Invoices window).

2. If you have custom invoice templates, choose the invoice template you would like to use from the
drop-down list.

3. Inthe Customer:Job field, enter the name of the customer/job for whom you wish to create an
invoice.

4. If the Billable Time/Costs window pops up, choose to Add billable time or expenses.

= Create Invoices -0

Main  Formattng ~ Send/Ship  Reports 2 oA
e« B H K Boeteacon @ i [ Puetiater i  EbAddTimeicosts & B)create aBaten
Find New Save Delete @3 Memorize Mark As Print  Email Email Later Altach | @ Apply Credits Receive B Refund/Credit
S e Pending S e File Payments

» ﬁli«’ﬁ“/,\\m‘\".’\\\f//i’i(ﬁ“?\)/)

i SRS (as W7 |

shipTo2 =~ |

N

LTSSV E T Bristal, Sonya:Repairs -

TR rocecsss nvos 5

| n VOICG oaTE BILLTO sHPTO 1 7l
1215/2024 B gonya Bristol Sonya Bristol || summary |
. 5920 N. Lighthouse 5920 M. Lighthouse | |
INvOICE & ]

Bayshore, CA 94326 Bayshore, CA94326 J Phone 4155555239 |

1100 | Email sonyab@samplename.com
| Preferred delivery method E-mail |
TERMS DUE DATE | Open balance 000 f
1 |
Net30 ~ 011412025 B || Adive estimates o |
| Sales Orders to be invoiced 0|
ITEM i DESCRIPTION fauANTITY | umt i RaTe { AMOUNT | Tax 1 |
il | |
1 |

| CUSTOMER PAYMENT ’

| |
| Your customer can not pay online
|| Edit customer preferences

|
|

| RECENT TRANSACTION & |
| |
|| 0104124 Invoice - Paid 9569 |
«\f} 01/04/24 Payment 9569 |
1
| wWotes & |
L | |
| |
| |
Vour customer cant pay this invoice online T4 [8an Tomas v (7.75%) 0.00 | | |
Turn on P 0.00 1 I
GUSTOMER MESSAGE FAYMENTS AFFLIED 0.00 7 |
7 BALANCE DUE 0.00 1
| |
\ |
e saved Cone w0 | 1
TAL CODE R AN NP LA A VT

NOTES
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Fill in the Line Item Area

In the bottom half of the invoice (the detail or body of the invoice), you list each service or product
you're selling on its own line, along with the amount the customer owes for that item. Because
information about individual items is on separate lines, the lines are called line items.

But items are not just products you sell or services you provide to clients. Line items can be anything
you might want to put in the detail area of an invoice, like a discount, subtotal line, markup or sales
tax calculation.

@
o Step-by-Step: Complete the Line Item Area of an Invoice

1. Inthe Item field, choose the item you would like to add to the invoice. If you chose to add
billable expenses from the last exercise, these items will already appear in this section.

2. Press Tab until you reach the Quantity column.
3. Enter the quantity of the item for which you wish to invoice in the Quantity column.

4. Press Tab to enter the rate or per unit price for this item. If this item has been set up with a
default rate, it will automatically appear on the line, but you can overwrite it.

5. Press Tab to see the amount or extension of the quantity multiplied by the per unit price.

6. Let QuickBooks populate the Tax code for this item automatically, but you can overwrite it by
selecting a different tax code from the drop-down.

Removal Removal labor - cleaned up backyard in preparation for deck 6.5 35.00 227.50 MNon
Ir 1 Ir 1 labor - installed new deck 4 35.00 140.00 MNon
Lumber:Decking Decking lumber 650.00 650.00 Tax

NOTES
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Complete the Sales Form

(¢)

(@

Step-by-Step: Complete and Record the Invoice

Complete the Sales Form

At the top of the screen, in the Main tab of the ribbon, click the drop-down under Print >

Preview.

Click Zoom In above the previewed form and use the scroll bars to see the invoice items at
greater magnification.

Print ‘ Frev page Mext page I Zoom In ]l Help ‘ Cloze
Rock Castle Construction Invoice
1735 County Road
Bayshore, CA 94326 DATE INVOICE #
127152024 1100
BILLTO SHIPTO
Somya Bristol Sonya Bristol
5820 N. Lighthouse 5920 N. Lighthouss
Bayshors CA 94326 Bayshore, CA 34326
TERMS DUE DATE PROJECT
Net 30 1142025 Fepairs
DESCRIPTION QUANTITY um RATE AMOUNT
Removal labor 35.00 1.400.00
Subtotal S1.400.00
Sales Tax (7.75%) S0.00
Total $1.400.00
Payments/Credits 000
Balance Due $1.400.00

QuickBooks Desktop 2021 Client Training
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3. Click Close.

Complete the Sales Form

Frev page Mext page [ Zoom In ]| Help

‘ Cloze

Rodk Casile Construction
1735 County Road

Sales Receipt

Bayshore, CA 94326 DATE SALE NO
10:25°2025 3004
S0LD TO
Kristy Abererombiz
5647 Cypeass Hil R4
Bayshore CA 94326
CHECK NO. PAYMENT METH... PROJECT
3674 Famity Room
DESCRIPTION ary um RATE AMOUNT
Removal abor - clezned up backyand in preparation fr 65 3500 m7.50
dack
Installation labor - installed new deck 4 3300 140.00
Decldns bmber 63000 630.00T]
CA sales tax, 8an Tomas County T75% 50.38
Total $1,067.88

QuickBooks Desktop 2021 Client Training
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4. Invoices and other sales forms can be printed, emailed or saved as PDFs by clicking on the drop-
down under Preview or Email in the Main tab of the ribbon at the top of the form.

o
Main | Formatting  Send/Ship  Reports o oA
¢« B B X Boweow @ = FAE—
Find New Save Delete ¢hmemorize Mark As Print | Email Email Later Attach Bl Apply Credits  Progress  Receive B Refund/Credit
- - Pending File Payments.
Cook, BrianKitchen frecice! ﬁ [Kitehen Upg... SFSVEPN N Rock Castle Invoice » Cook, Brian:Kitchen
Bateh Customer
Packing Slip
I nvo'ce . ‘Shipping Label DATE BILLTO swpto (SAIPTOT ¥ 7
BeeH: Envelope 1211512025 B | Brian Cook Brian K. Cook SUMMARY
. 345 Cherry Lane 345 Cherry Lane
INvoIcE &
S ES DG Middlefield CA04482 Middlefield, CA04482 Phone 4155552248
1098, Email bcook@samplename.com
Preferred delivery method E-mail
TeRus ouE DATE Open balance 307233
Net 30 ~ [01M412027 @ || Active estimates 2
‘ ‘ ‘ ‘ ‘ Sales Orders to be invoiced 0
ITem | DESCRIPTION fouanTiT  fum i RaTE | AMOUNT Tax Unbiledfime and expenses:  3030.00
Appliance Gas Rangetop 247.50 247,50 Tax 4
Appliance Double oven 350.00 350.00 Tax CUSTOMER PAYMENT '
Appliance Dishwasher 450.00 450,00 | Tax Your customer can not pay online
Window Greenhouse Window 475.00 47500 Tax Edit customer preferences
Subtotal Subtotal 1,522.50 e
RECENT TRANSACTION e
LABOR 12115125 Invoice 1,636.69
Removal Removal labor o 4550 0.00 Non 2mizsimeice 595
Framing Framing labor 0 66.00 0.00 Non oTEs &
Instaliation Installation labor o 3850 0.00 Non
Subs:Tile &Coun... Installfle or counter 0 1,320.00 0.00 Non
SubsPaining  Painting [ £25.00 0.00 Non
SubsPlumbing | Plumbing 0 1,100.00 0.00 Non
SubsDrywall  Install drywall o 1,000.00 0.00 Non
v
e ‘Your customer can't pay this invoice onine T ganDominge | (7.5%) 1419
Turn o oL 1,636.69
CUSTOMER MESSAGE PAYMENTS APFLIED 0.00
= saLANCE DUE 1,636.69
vEwo custousr [T = Save & Close. Revert
Create mvoic T
Man  Formating  Send/Ship  Reports ~
S B 2 Boewacry @ g | Print Laler R Ada Tmeicosts [ -3
Find New Save Delete @dMemorize  MarkAs ~ Prit  Email || Emaillater  aftach = B Apply Credits  Progress  Receive B RefundiCredit
T T Pending h Payments
Cook, BrianKitchen Invoice aga Attached Files T Rock Castle Invoice > Cook, Brian:Kitchen
Batch Customer
| 1 DATE BLLTO supTo (ShiPTO s 2z
NVOICE gz 1211512025 B |Brian Cook Brian K. Cook SUMMARY
ol 345 Gherry Lane 345 Ghery Lane.
InvoicE &
Middlefield CA 94482 Middlefield, CA 94482 Phone 415-555-2248
1098 Email beook@samplename.com
Preferred delivery method E-mail
TERUS DUE DATE Open balance 3079.33
Net 30 = 011142027 @ || Actve estimates 2
‘ ‘ ‘ ‘ . . Sales Orders o be invoiced 0
ITEm | DESCRIPTION fouanTiTY i um i RaTE i AMOUNT P Tax . G expenses: 303000
Appliance Gas Rangetop 247.50 24750 Tax 4
Appliance Double oven 350,00 350,00 Tax CUSTOMER PAYMENT ¢
Appliance Dishwasher 450.00 450.00 Tax Your customer can not pay enline
Window Greenhouse Window 475.00 475,00 Tax Edit customer preferences
Sublotal Sublotal 152250 2
RECENT TRANSACTION e
LABOR 12115125 Invoice 1636.69
Removal Removal labor 0 4550 0.00 Non 121125 Inoice 595
Framing Framing labor 0 56.00 0.00 Non wores &
Instaliation Installation [abor o 38.50 0.00 Non
Sups:Tile &Coun... Install tile or counter 0 1,320.00 0.00 Non
SubsPainting  Painting o 825.00 0.00 Non
SubsPlumbing  Plumbing 0 1,400.00 0.00 Non
SubsDrywall  Instal arywall o 1,000.00 0.00 Non
v
e “our customer can't pay this invoice oniine. T4 SanDomingo  ~ | (75%) 114.19
Turn o TomL 1,636.69
CUSTONER NESSAGE PAYMENTS APPLIED 0.00
- sawnce ouE 1,636.69
wEwo cusronse (Tax  + Save & Close Revert
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Lesson 6 — Enter Sales Information Complete the Sales Form

5. In the Create Invoices window, record the sale and close the window by clicking Save & Close.

Create Invoices
Main Formatting Send/Ship Reports 0oa
- D 58 X CreateaCopy (@ 8 = Print Later 0] B add TmeiCosts i) [} Create a Batch
Fing New Save Delete @BMemorize  MarkAs = Print Emal [ |Emallater  Aftach B ApplyCredits Progress | Receive BRefund/Credit
M i Pending = = File Fayments
— - — - — - _
Customer [T
| . oare s s SHIDTO1 v
NVOICE se: s 12152025 B Brian Cook Brian K Cook SUMMARY ¢
o 345 Chemy Lane 345 Cheny Lane
INvoice &
Middlefield CA 94482 Middlefield, CA 94482 Phone 415-555-2248
1098 Email bcook@samplename.com
Preferred delivery method E-mall
TeRUS ouE DATE Open valance 397933
Net 20 v (01142007 @ || Active estimates 2
Sales Orders to be invaiced 0
ITEM DESCRIPTION QUANTITY M RATE AMOUNT Tax Unbiled e and expenses. 3030.00
Appliance Gas Rangelop 247.50 247,50 [Tax 4
Appliance Double oven 350.00 35000 Tax CUSTOMER PAYMENT ¢
Appliance Dishwasher 450,00 45000 |Tax Your customer can not pay online
Window Greenhouse Window 475,00 47500 Tax Edit customer preferences
Subtotal Subtotal 152250 2
RECENT TRANSACTION =
LABOR 12H5125 Invoics 1,636.69
Removal Removal labor ] 4550 0.00 Non 225 Invoice 585
Framing Framing labor o 66.00 0.00 Nen oTES &
Installation Instaliation labor 0 3850 0.00 Non
Subs:Tile &Coun... Installfile or counter o 1320.00 0.00 Non
SubsiPainting  Painting 0 825.00 0.00 Non
Subs:Plumbing  Plumbing o 1,100.00 0.00 Nen
SubsDywall  Instal drywall 0 1000.00 0.00 Non
v
Your customer can't pay this invoice oniine. T [8anDomingo ¥ | (7.5%) 114.19
Turn on oL 1636.69
CUSTOMER MESSAGE Fa o 0.00
. . 1,636.69
g (o) fever

QuickBooks records the invoice in your Accounts Receivable register.

If this were a sales receipt rather than an invoice, QuickBooks would record the sale in your
Undeposited Funds account, where it would stay until you deposit the money at the bank. This
assumes Undeposited Funds was chosen as the Deposit To account. If a checking or savings account
was selected as the Deposit To account, no separate deposit transaction would be required; the
money from the sales receipt would go directly into the bank account. The option to select where to
deposit the payment is available only when the Payments preference Use Undeposited Funds as a
default deposit to account is turned off.
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Complete the Sales Form

The Accounts Receivable register keeps track of how much money your customers owe you.

@]
0

1. Open the Chart of Accounts.

Step-by-Step: See the Accounts Receivable Register Display a Completed

Sales Receipt

2. Inthe Chart of Accounts, double-click the Accounts Receivable account. The register for

Accounts Receivable displays.

3. To open a transaction, double-click the transaction in the register, or click it once, then click the
Edit Transaction button at the top of the Accounts Receivable register toolbar.

= 1000 - Accounts Receivable —Oox
$ Goto.. | () Print.. | B Edit Transaction [ QuickReport
ATE NUMBER CUSTOMER ITEK an RATE AMT CHRG AMT PAD
TYPE DESCRIPTION CLA! BILLED DATE DUE DATE
1211212025 306 Teschner Anton:Sun Room 350000 4
PMT
1211212025 | 1093 Lew Plumbing - C:Storage Expansion 22000
NV 0111112027
12112/2025 | 10586  Nguyen, Tuan:Garage 2200.00
PMT
121142025 | 986 Jacobsen, DougKitchen 2,000.00
PUT
1211412025 | 1094 Natiello, EmestoKitchen 2,080.11
NV Paid
1211412025 | 1095  Natiello, EmestoKitchen 8,656.25
INV Paid
1211412025 | 1096 Natiello, EmestoKitchen 2,824.03)
INV Paid
121512025 Roche, Diarmuid:Garage repairs 440.00
PMT
121512025 Abercrombie, KristyRemodel Bathroom 7633.28
PMT
121152025 | 1087  Robson, DarciRobson Clinic 12420.98
M 2L
21152025 (1088 Cook, BrianKitchen 1,636.69 I
IV 0111412027
2116/2025 | 42000  Natiello, EmestoKitchen 13,560.39
PMT
1211512025 l
A
1-Line Show open balance ENDING BALANCE 93,007.93
Sotdy  Date, Type, NumberiRef Restore

4. Close the register.
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Repeat a Sale

Many of the sales you make in your business are ones you repeat again and again. For example, you

Repeat a Sale

may have a standing monthly order from a customer, or you may perform essentially the same

services for more than one client. QuickBooks lets you memorize sales forms so you don't have to
retype the information. In fact, QuickBooks allows you to memorize a transaction (several types) so it

is automated on a schedule if it's something that happens regularly in exactly the same way.

@)
o)

Step-by-Step: Memorize the Invoice

1.

Make sure you have the invoice you want to memorize displayed on your screen.

2. From the Main tab of the ribbon in the upper right of the task bar, choose Memorize. The
Memorize Transaction window appears on top of the invoice.

E Create Invoices
Main | Fomattng  Send/Ship  Reports
e B H 34 Q =3 [ PantLater B acaTmercosts  [3] B Bloracasaen
Fnd | New Save Deid MarkAs | Pint Email [ | Emailaler | Aftach Appy Credits  Progress  Recerve B9 RefundiCredit
s 79 Pending S i ros ®
e AN z B = e z _
| H oMTE s To swpro (SHiRTO1 ¥
NVOICE sec riston e e 12152025 B | [Bran Cook Brian K. Cook
f— 345 Cherry Lane 345 Cherry Lane
= Widdlefield CA 94482 Middlefield, CA94482
© Addio my Rerinders (it cancel
‘ 5 TeRus oue owE
@ Do NotRemind Me
Net30 - o407 @
© Automate Transaction Entry
mem oESCRIPTIO v n rae AmoUNT T
Appliance Gas Rangetop 24750 247.50 [Tax 4
Appliance Double oven 35000 350.00 Tax
Appliance Dishwasher 450.00 450.00 Tax
Window Greenhouse Window 475.00 475.00 Tax
Subtotal subtotal 152250
LABOR
Removal Removal labor 0 4550 0.00 Non
Framing Framing labor 0 66.00 0.00 Non
Installation Installation labor o 3850 0.00 Non
Subs:Tile &Coun... Instaltle or counter 0 132000 0.00 Non
SubsPaining  Painiing 0 825,00 0.00 Non
SubsPlumbing  Plumbing 0 110000 0.00 Non
SubsDnwall  Install dywall o 1,00000 0.00 Non
v
e I customer can't pay this invoics online ™ [8anDomingo ¥ (7.5%) 1419
on Tom 1,636.69
a i 0.00
- oue 1,636.69
cusoucr (L Save & Close Revert

—o
SuMMARY ¢
Phone 4155552248
Email beook@samplename.com

Preferred delivery method E-mail
Open balance 307933
Active estimates 2
Sales Orders to be invoiced 0
Unbilled time and expenses:  3,030.00
CUSTOMER PAYNENT ¢

Your customer can not pay online
Edit customer preferences

RECENT TRANSACTION e
12018125 Iveice 163659
12011725 Iveice 595
wores ¢

the default description QuickBooks has provided.

Click the radio button next to Do Not Remind Me.

In the Name field, type a description that will help you recognize the memorized invoice or keep

Click OK. If your computer’s sound is turned on, you'll likely hear a camera taking a picture.

Close the Create Invoice, Accounts Receivable register and Chart of Accounts windows.
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@}

9! Step-by-Step: Recall a Memorized Sale

1. From the Lists menu, choose Memorized Transaction List.

File Edit View

Favorites Company Customers Vendors

Chart of Accounts
Item List

Fixed Asset ltem List
UM Set List

Price Level List
Sales Tax Code List
Payroll ltem List
Payroll Schedule List
Class List

Workers Comp List

Other Mames List
Customer & Vendor Profile Lists
Templates

Memuorized Transaction List Ctrl+T
Add/Edit Multiple List Entries

Manage Groups

Employees

Repeat a Sale

2. Double-click the memorized transaction you just added. Remember, this is just a snapshot copy
of an invoice that you've memorized, not the original invoice. It is the beginning of a new invoice
that already has some copied information from the original invoice.

3. Make any necessary changes on this copy of the memorized invoice (such as the date or other
details) before you save it.

TRAMSACTION NAME

- Kitchen Example Invoice

i TYPE

Invoice 11000

Memorized Transaction List
i AMOUNT i FREQUENCY

ounts Rece.

P AUTO

i NEXT DATE

+ Overhead General Journal 13100 - Pre-paid Insur..

+ Recurring Depr Entry - Monthly General Journal 54000 - Job Expenses... 19.60 Monthly s 12/31/2025

+ Sergeant Insurance Check 10100 - Checking 675.00 Monthly 01/15/2026
Memorized Transaction ¥ Enter Transaction

4. Click Save & Close to record the invoice.

5. Press the Esc key to close the Memorized Transaction List.
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Create Batch Invoices

Create Batch Invoices

Batch invoices are a way to assemble a list of customers to whom you can send similar invoices all at

once. This can be great for recurring service billing.

(]

o Step-by-Step: Create a Batch Invoice

1. From the Customers menu, choose Create Batch Invoices.

2. Click the drop-down next to All fields to see the field types that are available for searching.

3. Inthe Look for field, you can search for a specific search term. Click the drop-down in All fields
to see the field types that can be selected for finding the search term.

Batch Invoice {

SEARCH

Step 1 of 3: Select a billing group or choose customers and click Next.

Look for [|

Search Reset

Search Results

NAME &

Abercrombie, Kristy

Family Room
Finished Basement
Kitchen
Remodel Bathroom
Allard, Robert
Remodel
Babcock's Music Shop
Remodel
Baker, Chris

Family Room

Select All Clear All

| in [ All fields

-]

! BALANCE TO... !

I

0.00
0.00
0.00
0.00
14,510.00
14,510.00
0.00
0.00
0.00
0.00

[ Search within results

Met 30
Met 30
MNet 30
Met 30
MNet15
Met 15
MNet 15
Met 15
Met 30
MNet 30

Add >

< Remove

BILLING GROUP

Manage Groups What iz a billing group?

CUSTOMERS IN THIS GROUP

Save Group

Help Cancel

QuickBooks Desktop 2021 Client Training
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Batch Invoice x

Step 1 of 3: Select a billing group or choose customers and click Next.

SEARCH BILLING GROUP

Lookfor  basement in

All fields
searen feset Manage Groups What is a billing group?
Mame fields g P g group
Search Results Address fields

_ Phone fields
NAME = i g CUSTOMERS IN THIS GROUP

CustomerJob Name

Family Room

Company Name

Finished Basement

Ci =
Kitchen < Add
State
Remodel Bathroom
ZIP < Remove
Allard, Robert
E-mail
Remaodel

Account Number
Babcock's Music Shop

Remodel
Custom fields
Baker, Chris
Motes
Family Room
v
Select All Clear All Save Group

4. Click Search.

Step 1 of 3: Select a billing group or choose customers and click Next.
SEARCH BILLING GROUP
Lookfor  basement in  Customer.Job Name - -
Reset () Search within results Manage Groups  \Whatis a billing group?
Search Results
MAME & ! BALANCE TO... | TERMS CUSTOMERS IN THIS GROUP
Abercrombie, Kristy 0.00 Net30 &
Family Room 0.00 Met 30 l
Finished Basement 0.00 Met 30
Kitchen 0.00 Met 30 AdZ
Remaodel Bathroom 0.00 Net 30 T —
Allard, Robert 14,510.00 Met 15
Remaodel 14,510.00 MNet 15
Babcock's Music Shop 0.00 Met15
Remaodel 0.00 Net15
Baker, Chris 0.00 Met 30
Family Room 0.00 Met 30
v
Select All Clear All Save Group
Back Help Cancel

5. Inthe Billing Group field, enter a name for your batch, then select the Enter or the Tab key. If you
entered a Billing Group name that does not exist, you will receive a prompt to set up this group.
Select Setup to confirm you wish to create this new Billing Group.
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Step 1 of 3: Select a billing group or choose customers and click Next.

SEARCH BILLING GROUF

Look for  basement in  CustomerJob Mame - Basements -

Search Reset ("] Search within results o g i Mg group?

Search Results

I BALAMCE TC... | TERM]

NAME &

Melton Johnny Basement Remodel

Vasquez, Anabel:Basement Remodel 0.00
Abercrombie, Kristy:Finished Basement 0.00
Add >
< Remove
Select All Clear All Save Group

- || ome
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Create Batch Invoices

6. Highlight each client from the Search Results you wish to add to the Billing Group, one at a time,
then choose Add, or you can click Select All. (If you added a client in error, highlight it in the

Customers in this group field and choose Remove.)

Batch Invoice

Step 1 of 3: Select a billing group or choose customers and click Next.

SEARCH

Look for Ibasement

'4

Search Results

Customer.Job Name -

Iin

Reset [1 Search within results

MAME & ! BALANCE TO... I TERMS

Melton, Johnny

ment Remodel
‘Basement Remodel
Abercrombie, Kri

Add =

Select All Clear All

Back

=< Remove

BILLING GROUP
Basements hd

Manage Groups

Whatis a billing group?

Billing group ©  Basements

CUSTOMERS IN THIS GROUP

Melton, Johnny.Basement Remodel

Vasquez Anabel:Basement Remodel

Abercrombig, Kristy:Finished Basement

Help Cancel

7. Click Save Group.

8. Click Next.
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9. Choose the date of the invoices being issued in one batch as well as the invoice template you
wish to use for the entire batch.

10. Enter the information you would like on your invoice.

11. Click Next.
Batch Invoice x
Step 2 of 3: Choose the line items for the batch invoice and click Next. How do | enter the terms, sales tax
rate, and send method?
Date |p1/01/2026 B8| Template  |Rock Castle Invoice =
ITEM ¢ DESCRIPTION PQUANTITY | WM i RATE P AMOUNT P TAX
Floor Plans Floor plans 1,000.00 1,000.00 Mon A
Blueprints Blueprints 1,500.00 1,500.00 Mon
Framing Framing labor 15 55.00 825.00 Mon
Installation Installation labor 25 75.00 1,875.00 Mon
v
TOTAL 5,200.00
CUSTOMER MESSAGE
-
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Lesson 6 — Enter Sales Information

12. Review the list of customers checked in the next window and click Create Invoices.

Batch Invoice x
Step 3 of 3: Review the list of invoices to be created for this batch and click Create Invoices.
Invoice Date: 01/01/2026
SELECT ! CUSTOMER P TERMS | SEMD METHOD | AMOUNT | TAXC.. | TAXR.. [ TAX P TOTAL P STATUS
: o Melton, Johnny:Basement Remodel Met30  Email 5,200.00 Tax 775% |0.00 5,200.00 OK A
o Vasquez, Anabel:Basement Remodel Met15  Mone 5,200.00 Tax T775% 0.00 5,200.00 OK
Abercrombie, Kristy.Finished Basement  Met 30 Email 5,200.00 Tax T775% | 0.00 5,200.00 OK
v
Back Next Create Invoices Help Cancel

13. The Batch Invoice Summary appears. Click Email to send the invoices to your customers or Print

to print the invoices.

Batch Invoice Summary

Your invoices are created. Theyre marked for print or email based on each customers
Preferred Send Method.How do | enter or change the Send Method?

0 marked for print Print

2 marked for email Email

1 unmarked (you can send these later)

14. Click Close to close the Batch Invoice Summary.
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Enter a New Item

Items are what we use on sales forms, e.g., estimates, sales orders, invoices, credit memos, and sales
receipts. ltems represent the products or services that are sold and each item is mapped to one or
more accounts in QuickBooks. ltems can be mapped to one, two or three accounts in QuickBooks,
depending on the item setup.

® One-sided Items - These items are used only on either a sale or a purchase form, not both. For
example, if you sell consulting services, you may have an item named Consulting for use on your
invoices. This item will be mapped to an income account to view on your Profit & Loss report. If
this item were used on a purchase transaction, it would post a negative transaction to your
income account.

® Two-sided Items - These items are used on both a sale and a purchase form. The setup for these
items allows you to post to an income account when used on a sales form and post to an
expense account when used on a purchase form. In the example of Consulting as a two-sided
item, this item will be mapped to an income account on sales transactions, but will also be
mapped to a cost of goods sold or expense account on purchase transactions (when recording
sub-contractor labor, for example).

® Three-sided Items - Three-sided items are used for inventory. The setup of these items allows
you to purchase the item and receive it into your Inventory Asset account (part 1). When you sell
the inventory, the item posts to your Income account (part 2) and makes a Cost of Goods Sold
entry (part 3).

In this section, you will look at a one-sided item entry.
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(@

o Step-by-Step: Add a One-sided Item

1. From the Lists menu, choose Item List.

Enter a New Item

Look for in Allfields - Reset [ Search within results
amE DESCRIFTION i TYPE i ACCOUNT i TOTAL QUANTITY ...
» Labor Senice 40100 - Construction Inco 0.00
» Removal Removal labor Senice 40100 - Construction Inco 35.00
» Repairs Repair work Senice 40100 - Construction Inco 35.00
+ Subs Subconfracted semvices Senvice 40100 - Construction Inco 0.00
+Carpet Install carpeting Senice 40100 - Construction Inco 0.00
+Drywall Install drywall Senvice 40100 - Construction Inco 0.00
+Duct Work Heating & Air Conditioning Duct Work Senice 40100 - Construction Inco 0.00
+Electrical Electrical work Senvice 40100 - Construction Inco 0.00
+Insulating Install insulation Senice 40100 - Construction Inco 0.00
+Metal Wrk Metal Work Senvice 40100 - Construction Inco 0.00
+Painting Painting Senice 40100 - Construction Inco 0.00
+Plumbing Plumbing Senvice 40100 - Construction Inco 0.00
+Roofing Roofing Senice 40100 - Construction Inco 0.00
+Tile &Counter Install file or counter Senvice 40100 - Construction Inco 0.00
> Cabinets Cabinets Inventory Part 40100 - Construction Inco o o 0.00
+Cabinet Pulls Cabinet Pulls Inventory Part 40100 - Construction Inco 423 0 0.00
+Light Ping Light pine kitchen cabingt wall unit Inventory Part 40100 - Construction Inco 3 2 1,799.00
+ Door Frame standard interior door frame Inventory Part 40100 - Construction Inco pal 0 0.00
» Hardware Inventory Part 40100 - Construction Inco o o 0.00
+Brass hinges standard interior brass hinge Inventory Part 40100 - Construction Inco 246 o 0.00
+Doorknobs Std | Standard Doorknobs Inventory Part 40100 - Construction Inco 124 o 30.00
+LkDoorknabs Locking interior doorknobs Inventory Part 40100 - Construction Inco 122 o 38.00
> Wood Door Doors Inventory Part 40100 - Construction Inco 1 o 0.00
+Exterior Exterior wood door Inventory Part 40100 - Construction Inco 18 o 120.00
Item v Acfivities v Reports ¥ Excel v Attach [ |nclude inactive

2. Click the Item drop-down at the bottom left of the window then choose New.

Lookfor in Al fields - m Reset 7] Search within resufts
NAE CESCRIFTION { Tvre T OTAL GUANTITY ... | ON SALES ©.. | FRICE § aTTAcH
< Labor Senice 40100 - Construction Inco 0.00
- Removal Remaval lavor Senic 40100 - Construction Inco... 35.00
< Repairs Repair work Senice 40100 - Constrution Inco 2500
- subs Subcontracted services Senic 40100 - Construction Inco... 0.00
«Carpet Install carpeting Senice 40100 - Constrution Inco 0.00
<Drywall Install drywall Senic 40100 - Construction Inco... 0.00
+Duct Work Heating & Air Gonditioning Duct Wark Senice 40100 - Constrution Inco 0.00
oElectrical Electrical work Senic 40100 - Construction Inco... 0.00
+Insulating Install insulation Senice 40100 - Constrution Inco 0.00
o Metal Wk Metal Work Senic 40100 - Construction Inco... 0.00
Senice 40100 - Constrution Inco 0.00
ew ClrieN
Edi em CUlTE Senice 40100 - Construction Inca... 0.00
Duplicate fiem Senice 40100 - Constrution Inco 0.00
Delete ltem Gi+D  unter Senic 40100 - Construction Inco... 0.00
«  Add/Edit Multiple ltems Inventory Part 40100 - Construction Inco. 0 0 0.00
S Inventory Part 40100 - Construction Inco... 423 0 0.00
Make Itemn Inaclive len cainet wall unit InventoryPat 40100 - Genstruclion Inco 8 2 1,790.00
o Show Ingclive tems or door frame Inventory Part 40100 - Construction Inco... 21 0 0.00
| v Hierarchical View Inventory Part 40100 - Construction Inco. 0 0 0.00
Flat View
or brass hinge Inventory Part 40100 - Construction Inco... 246 0 0.00
Customize Columns
knobs InventoryPat 40100 - Construction Inco 124 0 3000
Use GV doorkmons Inventory Part 40100 - Construction Inco... 122 0 38.00
Eind in Transaclions: -
InventoryPat 40100 - Construction Inco 1 0 0.00
Print List CH+P gpor Inventory Part 40100 - Construction Inco... 16 0 120,00
Re-sort List
ttem * | Activities |+ Reports | v|| Excel v Attach | [ include inaciive
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Enter a New Item

3. Inthe New Item window, choose an item type (e.g., Service as in the screen capture below), from

the Type drop-down list.

= IMPORTANT: When you select an item type, a description of how that item should be used will appear to

the right of the drop-down box.

= Mew ltem

TYPE

- Useforsenices you charge for or purchase, like

specialized labor, consulting hours, or professional

fees.
ltem Mame/Mumber [ | Subitem of
UNIT OF MEASURE
LI Set - Edit...

[7] This semvice is used in assemblies oris performed by a subcontractor or partner

Description Rate
Tax Code Tax -
Account

— O X
Cancel
Next
Notes

Custom Fields

Spelling

[ Item is inactive

4. Assign an item name or number in the ltem Name/Number field.

5. In the Description field, enter the default information you would like to appear when this item is
used on a form. (This default information can be overwritten on any individual transaction.)

6. You can assign a standard per unit selling price in the Rate field.

7. Inthe Tax Code field, assign a standard taxable or non-taxable code.

= IMPORTANT: [tems marked as Non-taxable in the setup will not accrue sales tax on sales forms. See the

Sales Tax training section for additional information.

8. Inthe Account field, choose the appropriate Income account to post to when this item is used on

sales forms.
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9. Click OK to add the new item to the Item List.

= Mew [tem - O %
TYPE OK
e - Usefor senices you charge for or purchase, like
specialized labor, consulting hours, or professional Cancel
fees.
Next
[termn MameMumber [ Subitem of
Notes
Drafts -

UNIT OF MEASURE Custom Fields

LM Set - Edit... Spelling

[] This semvice is used in assemblies oris performed by a subcontractor or partner

Description Rate

Crraft blueprints Tax Code Mon -

Account 40100 - Constr.. = [ Item is inactive

10. Close the ltem List.
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Create New Price Levels

For each price level you create, assign a name and percentage increase or decrease to the item'’s
base or standard sales price. You can create up to 100 price levels in QuickBooks Pro and Premier to
use on invoices, sales receipts, estimates and credit memos. To enable price levels in a company,
click Edit >Preferences ->Sales & Customers > Company Preferences > Enable Price Levels.

@
o Step-by-Step: Create a New Price Level

1. From the Lists menu, choose Price Level List.

=]

Price Level List -
NAME TYPE DETAILS
Industrial Fixed % -15.0%)
Residential Fixed % -5.0%

Door Replacement Special Per ltem varies per item

Kitchen Upagrade Package
Pretell Real Estate Rates

Per ltem varies per item

Per ltem varies per item

Price Level ¥ Reports v

2. From the Price Level menu button, choose New.

3. Inthe Name field, enter a name for the price level.

4. Click the Type drop-down list, then select Fixed % or Per Item. This setting determines if you
have a fixed markup/discount or if you would like to set up custom prices per item. (Per ltem
Price Levels are not available in QuickBooks Desktop Pro.)

5. Setyour rounding parameters.

6. Click OK.

7. Close the Price Level List.
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Associate Price Levels with Customers

When you assign price levels to customers, QuickBooks calculates rates and amounts on sales forms
based on the price level associated with that customer.

@)
o  Step-by-Step: Associate a Price Level with a Customer

1. Open the Customer Center.

2. Inthe Customers & Jobs List, select the customer whose price level you wish to set.
3. Double-click the customer name to open the customer detail page.

4. Click the Payment Settings tab.

5. From the Price Level drop-down list, choose the price level you want to associate with the
customer.

Edit Customer

cuUsTOMER Nave | Lew Plumbing - C

CURRENT BALANCE 220.00 How do | adjustthe current balance?

Address Info
ACGOUNT NO. GREDIT LIMIT
Payment Settings
=ay a FAYMENT TERMS | Met 30 v PRIGE LEVEL [pommercial hd ]
Sales Tax Settings PREFERRED - < Add Mew =
: E-mail v
DELIVERY METHOD
Additional Info )
- FREFERRED ' Master Card v
PAYMENT METHOD
Industrial

CREDIT CARD INFORMATION ONLINE PAYMENTS  Reesidential

GREDIT GARD NO. | 992900000002222 Letthis custom  poor Replacement Special

— — " Kitchen Upgrade Package
ExP.DaTE 09 | /2005 B8 Credit Car

Pretell Real Estate Rates

[ Bank Tran

[ Customer is inactive

NAME ON CARD

ADDRESS

ZIF { POSTAL CODE

Lew Plumbing

221 0ld Bayshore Rd

94326

Cancel Help
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6. Click OK to close the Edit Customer window and save your changes.

Now when you create a sales form for this customer, the price will automatically be adjusted
according to the price level. However, you can still select the base or standard price, or any of the
other prices associated with other price levels, for each item by clicking on the drop-down next to
the rate that appears. You will also be able to overwrite the price altogether and enter a custom
price for this sales form. See the next section, Assign Special Prices to Individual Line Items, for
situations in which you might want to use this feature.

NOTES

QuickBooks Desktop 2021 Client Training 30



Lesson 6 — Enter Sales Information Assign Special Prices to Individual Line Items

Assign Special Prices to Individual Line Items

In addition to associating price levels with customers, you can also use other price levels and special
prices on an individual basis on sales forms. Some examples of when you might want to do this are:

® You've associated a price level with a customer but want to charge the base sales price for an
item on a sale to that customer

® You wantto use a price level for one or more items, but you don't want to assign a price level to
the customer for whom you're recording the sale

® A customer has negotiated a special one-time-only price with you on specific items

@
o  Step-by-Step: Apply a Price to a Single Line Item

1. In a sales form with line items, click in the Rate column and select the price level you want to use
from the drop-down list that displays (or you can enter your own price for that item, even if it is
not in the drop-down list).

2. When you move out of that field on the form QuickBooks recalculates the amount and balance
due.

NOTES
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Use the Income Tracker

The Income Tracker Center helps you manage collecting payments from your customers. It lists all
overdue and nearly-due invoices in a single place, as well as unbilled estimates. You can send email
reminders to one customer or many customers, and it tracks customer notes about your collection
efforts.

@
o  Step-by-Step: Review Overdue and Nearly-due Payments

for All Customers

1. From the Customers menu, select Income Tracker (or open the Customer Center and click
Income Tracker).

2. Click any of the money bar's colored tabs on the top to filter the information, if desired.

[#
s oo o

48,569.31 1,413.68 31,583.33

s esnuaTes 3 5ALES ORDERS 17TE & ExPENSES o overoue

cus [~] wvee [ | swmus Al v oare Al -
u] e womseR | paTe ¥ oue oaTe AsouT OPENBALANCE | LaST SENTOATE | sTATUS acTion
[J Metton, Johnny:Basement Remodel Invoice 1100 1101126 1431126 5,200.00 5,200.00 Pending Open

[] Vasquez, Anabel:Basement Remodel Invoice 1101 1101126 1116126 5,200.00 5,200.00 Open

[J Gook, Brian:Kitchen Invoice: 1098 1215125 10427 1,636.69 1,636.69 Open

[J Morgenthaler, Jenny:Room Addition Sales Order 7003 1215125 114127 27153 27153 Open

[J Robson, Darci:Robson Clinic Invoice: 1087 1215125 12115126 1242098 12,420.98 Open

[ Lew Plumbing - C:Storage Expansion Invoice 1093 12112125 11127 220.00 220.00 Open

[J Gook, Brian:Kitchen Invoice: FC6 12111725 1ot 595 595 Open

[] Campbell, HeatherRemode! Invoice 1092 1211025 12125126 13,900.00 13,900.00 Open

[J Pretell Real Estate: 155 Wilks Blvd. Invoice 1090 1211025 1409127 1,715.00 1,715.00 Qpen

[ Violette, Mike:Workshop Invoice: 1089 12/05/25 20327 573223 473223 Open

[ Ecker Designs:Office Repairs Invoice 1086 11130125 12/30/26 1,468.30 1,468.30 Qpen

[J Teschner, Anton:Sun Room Invoice: 1085 11128125 12113126 830595 565905 Open

[ Burch, Jason:Room Addition Invoice 1083 1112525 12/25/26 1,005.00 1,005.00 Qpen

[J Cook, Brian:2nd story addition Invoice: 1081 1112525 12125126 5,418.00 5,418.00 Open

[J Cook, Brian:Kitchen Invoice 1080 1112525 12/25/26 1,636.69 1,636.69 Qpen

[ Jacobsen, Doug:Kitchen Invoice: 1082 1112525 12125126 472500 2,320.00 Open

[ Melton, Johnny-Dental office Invoice. 1079 12025 1212026 1275414 8618564 open

[J Hendro Riyadi:Remodel Kitchen Invoice: 1077 1118125 1118126 422300 422300 Open

[ Vasquez, Anabel:Basement Remodel Sales Order 7002 11A8ms 1200326 172400 862,00 open

[J Cook, Brian:Kitchen Estimate 610 1117125 1217126 422541 422541 Open

[ Ecker Designs:Office Repairs Estimate 609 11116125 1116126 582880 5,828.80 open

[] Pretell Real Estate: 155 Wilks Blvd. Invoice: 1074 1115125 12115126 1,07250 1,07250 Open

[ Vitton, David:Remodel Kitchen Invoice. 1076 11825 1173026 700.00 700.00 open

[] Pretell Real Estate:75 Sunset Rd. Estimate 608 1112125 1112126 18,409.93 5,668.66 Open

[] Abercrombie, Kristy:Remodel Bathroom Estimate 606 10130125 10/30/26 3,114.00 3,114.00 Open

[] Mackey's Nursery and Garden Supply:Gr... Invoice 1068 1012025 11104126 13,900.00 13,900.00 Open

t Batch Actions - Manage Transactions - Showing 1 - 50 of 50 @

3. Click the down-facing arrow next to Select in the Action column for a list of actions you can take
on each line.

4. Inthe Unbilled section (the left half) of the money bar, click the colored tab for Estimates. These
are open estimates that can be turned into invoices by using the Action field.
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5. Place checkmarks in the boxes in the far left column next to each estimate (or one checkmark in

the top box to indicate you are choosing all of them). Click Batch Actions at the bottom which, in
this case, enables you to batch email them or mark them inactive.

Income Tracker i

&
e oo oo
48,569.31 1,413.68 31,583.33 10 3 0.00 |
& EsTATES o overoue opaDLAST s00AYS

2 SALES ORDERS. 17 TIME & EXPENSES

cusTouER- 108 |All v| Tree [Estimates v| swus [Open

v | pate Al Clear / Show All

CUSTOMER TYPE NUMEER : DATE ¥ AMOUNT OPENBALANGE | LAST SENTDATE | STATUS AGTION
L . ] S ] S N - |
Ecker Designs:Office Repairs Estimate 609 11/16/25 582880 5,828.80 Open

Pretell Real Estate:75 Sunset Rd. Estimate 608 112125 18,409.93 5,668.66 Open

‘Abercrombie, Kristy'Remodel Bathroom Estimate 608 1013025 3,114.00 3,114.00 ‘Open

Cook, Brian:2nd story addition Estimate 605 101125 22,427.44 22,427.44 Open

Cook, Brian-Kitchen Estimate 604 1011125 804189 7.,305.00 Open

Print Selected

WaicAs Inacive u
t BatenActions | -

ToTAL 48,569.31
Manage Transactions ~ +

Showing 1 - 6 of 6 @B
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6. The Manage Transactions button at the bottom left enables you to launch a new customer-
related transaction such as a new invoice or estimate, or to edit the currently highlighted row.

48,569.31 31,583.33
SESTMIEY 17 TIME & EXPEN SES.
cusTomer-Jos Al ~ vvee Estimates ~ | starus |Open ~ oate All - Clear / Show All
CUSTOMER TYPE NUMBER | DATE v AMOUNT OPEN BALANCE | LAST SENT DATE | STATUS ACTION
T S 7 S A N - |
Ecker Designs:Office Repairs Estimate 609 1116125 5,828 80 5,828.80 Open
Pretell Real Estate:75 Sunset Rd. Estimate 608 1225 18,409.93 5,668.66 Open
‘Abercrombie, Kristy-Remodel Bathroom Estimate 606 1030125 3,114.00 3,114.00 Open
Gook, Brian:2nd story addition Estimate 605 101125 22,427 44 22,427 .44 Open
Cook, Brian:Kitchen Estimate 604 10/11125 8,94169 7.,305.00 Open
Sales Orders
Sales Receipts
‘Statement Charges
Receive Payments
Credit Memos/Refunds
Edit Highiighted Row o 48,569.31
1 Batch Actions é Manage Transactions - Showing 1 - 6 of 6 @

7. Close the Income Tracker.

NOTES
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Create Single Invoice Letters

@
9!  Step-by-Step: Create an Invoice Letter

1. From the Reports menu, choose Customers & Receivables > Open Invoices from the
submenu.

2. Inthe on-screen Open Invoices report, double-click the open invoice for which you would like to
send a letter.

3. Under the Send/Ship tab of the ribbon at the top, click the Prepare Letter icon to display the
drop-down list.

4. Select Prepare Letter in the drop-down. If QuickBooks prompts you to find letters, click Copy.

5. Choose the type of letter you wish to create.

Letters and Envelopes
[DETCTOTDE
ypress HillRd |~ Choose a Letter Template
pre CA 94326

(@ Letter templates available for invoice letters.

Irs. Kristy Aberg \Cover Letter

Invoice Letter with Details

%Windnw Envelope Cover Letter

%Windnw Envelope Invoice Letter with Details

7% Create or Edit a letter template.

6. Click Next.
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7. Enter the appropriate name and title for the letter signature.

Letters and Envelopes

[DETCTOMDIE
lypress HillRd | Enter a Name and Title
nre CA 94326
Faor letters with fields for signature and title, enter how you want to sign

off.
Irs. Kristy Aberg

Mame  Esther Friedberg Karp
o =— .

Title President & CEDQ

When you click Next:

« Letters will be created in a single Microsoft Word Document

« Each letter will start on a new page
« Editing your letters will not affect the original letter template

*You can continue working in QuickBooks and choose to print envelopes

8. Click Next.

9. Inthe next screen, indicate whether you wish to print envelopes as well. If you wish only to print a
letter, select Cancel.

Letters and Envelopes

(FETCTOMIDTE
lypress HillRd |~ Print Letters and Envelopes
wre CA 94326

Your options for printing letters and envelopes are:
Irs. Kristy Aberg

+ Print letters you've created by selecting Print in the Microsoft Word File menu

:

+ Print envelopes in Microsoft Word by selecting Next on this screen

+ Choose notto print envelopes by selecting Cancel on this screen

Back Next ‘ Cancel Help
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Create Single Invoice Letters

10. If you wish to print a letter and envelope, click Next. In this case, you will see an Envelope
Options screen appear. Choose your envelope size and return address, then click OK.

Envelope Options

Size 10 (41/8x912in) - Select:
ranvelope size

Rock Castle Construction

Bayshore, CA 94326
dialog.

Printer: Snagit 2013

Envelope Size: CHOOSE ENVELOPE OPTION S HERE

[+ Print return address +return address
« delivery point barcode

1735 County Road Click OK and then select fonts
and printing options on the next

| oK \ Cancel

Help
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Create Single Invoice Letters

December 15, 2025
Heather Campbell

98342 Sharondale Rd
Millbrae, CA 94030

Dear Heather,

ltem Description
Floor Plans  Floor plans
Installation Installation labor
Labor General Labor
Removal Removal labor

Sincerely,

Esther Friedberg Karp
President & CEO
Rock Castle Construction

Rock Castle Construction

Invaice Job Remodel
Invoice Number 1092
Invoice Date 12/10/2025
Invoice Due Date 12/25/2026
Invoice Amount $13,900.00
Invoice Balance $13,900.00

ltemized charges are shown below:

Qty
20
150
30
10

1735 County Road
Bayshore, CA 94326

Rate
150.00
60.00
50.00
40.00

Amount
3,000.00
9,000.00
1,500.00
400.00

This table summarizes your current invoice activity. Please review this information and let us
know if you have any questions.

Tax
Non
Non
Non
Non

Thank you for choosing Rock Castle Construction. We hope to work with you again in the future.

11. You can choose to print the letter (and envelope) from Microsoft Word® if you wish.

12. Exit from Microsoft Word.

NOTES
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Generate Reminder Statements

Reminder statements summarize a customer's account by listing recent invoices, credit memos and
payments received. You can use reminder statements when you bill via invoices, but want to remind
your customers about delinquent payments and/or total outstanding balances.

Reminder statements are different from other forms in QuickBooks such as invoices, sales receipts or
checks —they are not transactions. You can think of them as reports for your customers. Furthermore,
because QuickBooks already has all the information you need to create reminder statements, you
don't have to fill them out manually. Instead, you specify the recipients, review the type of
information that will appear on each statement, decide whether to add finance charges, and
generate them.

@
o Step-by-Step: Generate Reminder Statements

1. Under the Company menu item, click Home > Statements (or from Customers, select Create
Statements).
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Generate Reminder Statements

2. For Statement Date, enter the date you want to appear on the statement.

3. Set your statement period in the Statement Period From and To fields or select All open

transactions as of statement date.

4. Inthe Select Customers section, choose your recipients. Select additional options as they apply,
including either Create One Statement per Customer or Create One Statement per Job, and

if you want the invoice item details to appear on statements. Click Assess Finance Charges if

you would like to add finance charges to the statements. (If you want to assess finance charges
without sending out statements, you can click Customers -> Assess Finance Charges or access

the Finance Charges icon from the Home page.)

SELECT STRATEMENT OPTIONS

Create Statements

Statement Date 1215/2025 HE

® StatementPeriod From 11/16/2025 B T0 121152025 [

0 All open fransactions as of Statement Date

SELECT ADDITIONAL OPTIONS

Template

Intuit Standard Statement - Customize

Create One Statement  Per Customer -

SELECT CUSTOMERS

—
F=

=) All Customers

ol

Multiple Customers

|

One Customer

| Customers of Type

| Preferred Send Method

Preview

View Selected Customers...

[ « Show invoice item details on statemenis

)

Print staterments by billing address zip code
Print due date on transactions
Do not create statements:

« with a zero balance

with a balance less than

with no account activity

« forinactive customers

[ Assess Finance Charges... ]

Close Help

Automate sending statements and get paid faster

Sending statements manually can be exhausting. With payment reminders, you can
schedule, review, and send statements to your customers, effortlessly.

Go to payment reminders
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5. Enter an assessment date in the next window (Assess Finance Charges) if applicable. Click
Assess Charges.

Click the assess column for each customer for whom you wish to create a finance charge invoice.

Assessment Date

Finance Charge - Customize
! CUSTOMER ! OWVERDUE BaL. ! FINANCE CHARGE
Cook, Brian 0.00 4
o 121112025 Kitchen 70000 5.00
v
Mark All Unmark Al ] Mark Invoices "To be printed”

Customers with *s have payments or credit memos which have not been
applied to any invaice. The overdue balance does not include these credits.

Settings... Collection History | Assess Charges Cancel
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6. Back in the Create Statements window, click Preview. Those statements which reflect finance
charges will have a listing with “INV #FC” in the statement.

Statement

Rock Castle Construction

1735 County Road
Bavshore, CA 94326

Date

1152025

Brizn K. Cook
345 Chemy Lane
Middlfizld CA 4482

Amount Due Amount Enc.
$9,402.33

UM Date Transaction Amount Balance

11152023 Balanes forwand 1139071

2nd story addition-
112520235 IV #1031 3A18.00 17.008.71
— Window, 18@ $220.00= 3560.00
—- Interior, 10 @ $72.00 = T20.00

—- Exterior, 2 (@ $120.00 = 240.00

—- Exteror, 1 @ 512000 = 120.00

—- Tax: San Dominzo (@ 7.5% =373.00
11252025 BT -4085.30 1252341

Kitchen-
11252025 TV £1080. 1,636.69 1456010
— Bee attached specifications for brand and color of all
appliances and matenak

—- APTITANCES AND MATERTALS

—- Apgpliance, 1 @ 5247.50 = 247.50

— Appliance, 1 @ 535000 = 350,00

—- Apgpliance, 1 @ $450.00 = 430.00

—-Window, 1@ S475.00= 47500

—-LABOR

—-Ramoval 50.00

— Framin= S0.00

—- Ins tallation 30.00

—- Tz &Countar S0.00

—- Baintins 50,00

—- Plymbing 50.00

—- Dy all 50,00

—- Tax: San Dominzo @ 7.5% =114 18

11252025 BT -2.580.00 11,580.10
11252025 BT 422541 7,754.69

CURRENT 1-30 DAYS PAST 31-80DAYS PAST | 8180 DAYS PAST OVER 90 DAYS
DUE DUE DUE PAST DUE

Amount Due

8,702.33 000 0.00 0.00 0000 /40233

Page 1
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Generate Reminder Statements

Rock Castle Construction

1735 County Road
Bayshore, CA 94326

To:

Brian K. Cook
345 Chemry Lans
Middlefield CA 24432

Statement

Date

1152025

Amount Due

Amount Enc.

5940233

um

Transaction

Amount

Balance

NV #FC 6.

395

7.760.64 )

Fimance Charzs

—-Fin Chg 5383

—-Trvoies =42 for T00.000n 100152003
IV #1098.

- Appliznes 524750

— Appliznes 535000

- Appliznes $450.00

— Window $475.00

—-LABOR

—-Famaoval 50.00

—Framins S0.00

—- s tallation 50.00

—- Tz &Countar 30.00

—-Paintins S0.00

—- Plymbing 50.00

—- Dy all 50,00

—- Tax: San Dominzo @ 75% = 11418
IV £FC 127.

Finance Charze

—-Fin Chz 5500

—- Ervoics #1066 for T00.00 on 03012025

1,636.69

5,397.33

5.402.33

CURRENT

1-30 DAYS PAST 31-80DAYS PAST
DUE DUE

8180 DAYS PAST

DUE

OVER 80 DAYS
PAST DUE

Amount Due

870233

000 000

000

700.00

540233

Page 2

7. Click Close.

8. Close the Create Statements window.

NOTES

QuickBooks Desktop 2021 Client Training

43



Lesson 6 — Enter Sales Information Payment Reminders

Payment Reminders

QuickBooks Desktop can be set up to send out Payment Reminders on a schedule, so that you don't
have to send out statements (but you still can if necessary). Payment reminders are sent out by
QuickBooks based on their setup and the customer groups to which they are to be sent. Therefore,
you should create customer groups first before setting up payment reminders to be sent out.

@
o Step-by-Step: Create Customer Groups

1. Under the Lists menu item, click Manage Groups.
2. Select Create customer group.
3. Add a Name and Description for the group, then select Next.

4. Select Fields, Operator, and Values to define the group, then select Add. When you're done,
select Next, or you can leave these fields blank and select Next to add customers manually.

For example: You can create a group of active customers in California who have an open balance
of between $100 and $1,000.

5. Select Selected fields to see a summary of the fields that will be used for the customer group.

6. Click Next.
i Create customer group x
° o 3 @ Need help
Enter details Select fields View/select customers
Fields and values
Select fields and values to define your group.
Note: Skipping this step will display the complete list of customers where you can manually select or unselect customers to define your group.
Field ‘Operator Value
Status - l ‘ Equals - l ‘ Selected (1/2)
Add
Selected fields Clear all
State Equals CA X
Open Balance Between 100 and 1000 X
Status Equals Active X
Back Cancel Next
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7. You can check the box next to Automatically add new or remove existing customers based
on fields and values selected for this group. That way QuickBooks does the vetting of
customers for you when customers are added or their circumstances change. You can also click
the Selected fields expand caret to see the filters for this group.

Create customer group

o o ) Dz

Enter details Select fields View/select customers

» Selected fields (3)
Following is the list of customers who will be added to the group based on the fields and values you've selected.
Customers (3)
[ Automatically add new or remove existing customers based on fields and values selected in this group. ]
I ' |
B Name Type Over due balance  Terms Avg days to pay Years as customer  Status
Storage Expansion Commercial 220 Net 30 0 13 Years, 4 Months  Active
Sun Room Residential 565.95 Met 15 61 21 Years, 9 Months  Active
Remodel Kitchen Residential 700 Net 15 1] 13 Years, 4 Months  Active
e ______________________________________________________________________________________________] 13

Back Cancel

QuickBooks Desktop 2021 Client Training 45



Lesson 6 — Enter Sales Information Payment Reminders

Create customer group

o ) o Oreie

Enter details Select fields View/select customers

~ Selected fields (3)

State - Equals - CA  Open Balance - Befween - 100 and 1000  Status - Equals - Active

Following is the list of customers who will be added to the group based on the fields and values you've selected.

Customers (3)

Automatically add new or remove existing customers based on fields and values selected in this group.

o -
Name Type Over due balance Terms Avg days to pay Years as customer  Status
Storage Expansion  Commercial 220 Net 30 1] 13 Years, 4 Months  Active
Sun Room Residential 565.95 Net 15 61 21 Years, 9 Months  Active
Remodel Kitchen Residential 700 MNet 15 Q 13 Years, 4 Months  Active
o ] 3

Back Cancel

8. If you need to add customers to the group, search by the customer’s name. To remove a
customer from the group, clear the checkbox next to their name.

9. Select Finish.

10. You'll see a Customer group window appear, indicating you successfully created this new group.
Select OK.

Customer group

Group - California 100-1000 created successfully.

Customers will be automatically added or removed based on the
fields and values selected in this group.
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11. Now the Manage groups window lists the group you just created.

| Customer group b

@ Need help
Create and manage customer groups based on fields like customer type, state, and more. Create customer group
Name ~ Description ~ Created on - Actions
[ (%) California 100-1000 4/21/21 Select - l

@
9! Step-by-Step: Schedule Payment Reminders

1. Under the Customers menu item, click Payment Reminders.
2. Select Schedule Payment Reminders.
3. Choose Let’s get started.

4. Select the New schedule drop-down - Statement.

Payment reminders New schedule | ~

Statement

Help @ Get paid for your invoices online Cancel Save
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A new Statement card appears under Payment reminders.

5. Choose from Select customer group > Add reminder.

Schedule payment reminders

Payment reminders New schedule | ~
Statement @) <New schedule> ]
Send reminder lc[ Select customer group x ]with a statement on...
Help ® Get paid for your invoices online Cancel Save

Schedule payment reminders

Payment reminders

Statement () California 100-1000 [}

Send reminder to | California 100-1000 v | with a statement on... Edit customer group

Add reminder

Help ® Get paid for your invoices online Cancel Save
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Payment Reminders

6. The Add reminder window appears. Fill out the parameters for the payment reminder

(statement) for this group and click OK.

= Add reminder

When do you want to send this reminder?

Statement date: Day 5 of every month

What should be the statement period?

) Statement period | Select

What inveice details do you want to include?

ltem details Memo [] Due date

How would you want your statement to look like?

Statement template Intuit Standard Statement

Email template Basic Statement

Generate a separate statement for each Customer:.Job

@ Generate a statement for open ¥ ftransactions

Cancel

Customize

Edit

7. The Schedule payment reminders window appears with the new statement reminder listed.

Select Save.

Schedule payment reminders x

Help

Statement

Payment reminders

@) california 100-1000

Send reminder to | California 100-1000 ¥ | with a statement on...

Day 5 +

of every month Add reminder

® Get paid for your invoices online

New schedule =

I}

Edit customer group

Canee!
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After you've saved your reminder, you'll see this message with more information:

Payment Reminders

Schedule payment reminders

All set. QuickBooks will now prompt you to send reminders when they are due.

Ready to review and send your first reminder?

Lefsdoit

After you've sent the reminders, you can also...

= -
— - Actions
- - Em v
Track reminders Manage customer groups
Track reminders in sent emails and invoice history Add. remove, and update customer groups
¥ Don't show this window again Learn More

Close
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Enter Sales Information — Review Questions

1. When receiving payment at the time of sale, you create a in
QuickBooks.

2. When customers are returning items, you record the return on a

3. In QuickBooks you can record payments by customers made using which of the following?
a. Cash
b. Check
c. Creditcard
d. All of the above
4. True or false: QuickBooks lets you save sales forms as PDF files.
a. True

b. False

5. If you regularly invoice a customer for similar items or services, you can
the invoice to save time.
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6. From which list (or lists) does QuickBooks get the information for A, B and C in the graphic

below?

a.

b.

Main  Formatting Send/Ship  Reports HoAa
«» B Greate a Copy. =5 [ PrntLater Bhadamercosts ] [ Greate a Batch
Find New Save Delett @3Memorize  MarkAs ~ Prnt Emai [ |Emaillater | Attach B Apply Credis Progress  Receive B Refund/Credit
T T Pending T v File Payments
Cook, BrianKitchen - Remodel - Rock Castle Invoice -
I I o4e BILLTO supto SHIRTO1 @ s
NVOICE seerisory 1211512025 B | [Brian Cook A (G oo SUMMARY
- 345 Cherry Lane 345 Cherry Lane
INvoIcE =
Widdlefield CA94482 Widalefield, CA94482 Phone 415-555-2248
1098 Email beook@samplename.com
Preferred delivery metnod E-mail
TERMS DUE DATE Open balance 398433
Net3o B~ (011412027 B || Actve estimates 2
‘ ‘ . ‘ . Sales Orders to be invoiced 0
e | DESCRIPTION fouanTTy  §um | rate i AmouNT Tax . anG expenses: 303000
Appliance Gas Rangetop 247.50 247.50 Tax A
Appliance Double oven 350,00 35000 Tax CUSTOMER PAYMENT ¢
Appliance Dishwasher 450,00 450,00 Tax Your customer can not pay online
Window Greenhouse Window 475,00 475.00 Tax Edit customer preferences
Subtotal Subtotal 152250 B
RECENT TRANSACTION el
LABOR C 12015/25 Invaice 500
Removal Removal labor 0 4550 0.00 Non 1218128 Involce 163669
Framing Framing labor 0 66.00 0.00 Non NoTES 3
Installation Installation labor 0 3850 0.00 Non
Subs Tile &Coun... Install tile or counter 0 132000 0.00 Non
SubsPainting  Painting 0 825.00 000 Non
SubsPlumbing  Plumbing 0 110000 0.00 Non
Subs:Drywall Install drywall o 1,000.00 0.00 Non
v
“our customer can't pay this invoice oniine T [8anDominge ¥ | (7.5%) 114.19
Turn on TomL 1636.69
CUSTOMER WESSAGE PAYMENTS APPLIED 0.00
- BALANCE DUE 1,636.69
r=rs custouzr [Tax = Save & Close Revert

Enter Sales Information — Review Questions

7. List the item types used in the line item area of the invoice above.

On which of the following can you not use price levels?
a. Invoices
Sales receipts

Credit memos

Purchase orders
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9. QuickBooks Pro allows you to assign price levels or special prices to which of the following?
a. Specific customers
b. Individual line items on sales forms
c. Bothaandb
d. None of the above

10. If a wood door’s base price is $120.00 and you set the rounding option to 1.00 minus .11 for a
certain price level, what price might appear on an invoice for the wood door if that price level is

used?

a. $120.11
b. $120.89
c. $119.89
d. $119.11

11. Which of the two methods described in this lesson for providing customers with information
about overdue invoices allows you to assess finance charges?

a.

b.
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Review Activities

Use Rock Castle Construction (sample product-based company) to do these activities:

1. Create an invoice for Rock Castle Construction that uses the new Repairs:Plumbing line item.
Create the invoice for a new customer by adding information to the Customer list on the fly.

2. Filling out a sales receipt is similar to filling out an invoice form. Create a sales receipt for the
customer Rock Castle Construction and select the Undeposited Funds option. (You need to
select this option only if the preference to use that account as the default deposit to account is
not set.) After you create the sales receipt, open the Undeposited Funds account register to see
the transaction QuickBooks created automatically.

3. Create a new price level for Rock Castle Construction for their January sales event. You want all
the prices to be 10% off and rounded to the nearest $.95. Then create an invoice and add some
items. Apply the January sales event price level and see the effect on the price. How would you
change the price level so all prices are rounded to the nearest $.49?
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Answers to Review Questions

1. When receiving payment at the time of sale, you create a sales receipt in QuickBooks.
2. When customers are returning items, you record the return on a credit memo.
3. In QuickBooks you can record payments received from customers using which of the following?
a. Cash
b. Check
c. Credit card
d. YAll of the above
4. True or false: QuickBooks lets you save sales forms as PDF files.
a. vTrue
b. False

5. If you regularly invoice a customer for similar items or services, you can memorize the invoice to
save time.
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6. From which list (or lists) does QuickBooks get the information for A, B and C in the graphic
below?

a. Customers & Jobs List

b. Customers & Jobs List (if associated terms with the customer); Terms List

c. lItem List

Main | Formatting  Send/Ship  Reports B oA
¢ > B8 CrealeaCopy 4@ == Print Later 1] B Add Timercosts A ® Create a Batch
Find New Save Deiete @BMemoize  MarkAs Print  Email [T] Emallater  Attach =~ @3 Apply Credits Progress | Reccive B Refund/Credit
M M Pending M T File Payments
4| Cook, BrianKitchen Bl ichen Uoo. Remodel + BESIN S Rock Castle Invoice
I 1 oire BILTO supto (SHPTOT v v
NVOICE seciser 121152025 B Brian Cook A Brian K. Gook SUMMARY
o 345 Chery Lane 345 Cherry Lane
INvOICE #
Middlefield GA 94482 Middlefield, CA 94482 Phone 4155552248
1098 Email beook@samplename.com
Preferred delivery method E-mail
TERMS DUE DATE Open balance 398433
Net3o B~ (011412027 B || Active estimates 2
Sales Orders to be invoiced 0
ITEM i DESCRIPTION {QUANTITY i um i RATE i AMOUNT i TAX Unbilled ime and expenses:  3,030.00
Appliance Gas Rangetop 24750 247,50 Tax 4 '
Appliance Double oven 350.00 350,00 Tax CUSTOMER PAYMENT 'a
Appliance Dishwasher 450.00 450.00 Tax Your custamer can not pay online
Window Greenhouse Window 475.00 475.00 Tax Edit customer preferences
Subtotal Subtotal 152250 2
RECENT TRANSACTION <
LABOR c 12115125 Inuoice 500
Removal Removal labor 0 45.50 0.00 Nen 121812 Inoice 1636.69
Framing Framing labor 0 66.00 0.00 Non wores "
Installation Installation labor 0 3850 0.00 Non
Subs:Tile &Coun... Install file or counter 0 1320.00 0.00 Non
SubsPaining  Paining 0 825.00 0.00 Non
Subs:Plumbing  Plumbing 0 1.100.00 0.00 Non
SubsDrywall  Install drywall 0 1,000.00 0.00 Non
v
Your customer can't pay this invoice oniine T4 [8anDomingo | (7.5%) 114.19
Turn on TOTAL 163669
CUSTOMER MESSAGE PAYMENTS AFPLIED 0.00
—_— aaance oue 1,636.69
VEWD custouER [Tax = Save & Close Revert
TAX CODE

7. Listthe item types used in the line item area of the invoice above.
Service
8. On which of the following can you not use price levels?
a. Invoices
b. Sales receipts
c. Creditmemos

d. v'Purchase orders
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Lesson 6 — Enter Sales Information Answers to Review Questions

9. QuickBooks Pro allows you to assign price levels or special prices to which of the following?
a. Specific customers
b. Individual line items on sales forms
c. Y Bothaandb
d. None of the above

10. If a wood door’s base price is $120.00 and you set the rounding option to 1.00 minus .11 for a
certain price level, what price might appear on an invoice for the wood door if that price level is

used?

a. $120.11
b. $120.89
c. V$119.89
d. $119.11

11. Which of the two methods for providing customers with information about overdue invoices
allows you to assess finance charges?

a. Invoice letters

b. v'Reminder statements
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